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Abstract 

Many planning and land use decisions in New York State are controlled at the 

local (town or municipal) level, restricting the implementation of conservation practices 

to a local scale. This is not necessarily the best scale for conservation management 

(Groom et. at. 2006).   Watershed boundaries represent a more ecologically sound 

conservation unit, reflecting the natural scale of ecosystem processes rather than artificial 

political boundaries that blur the processes operating in separate ecological units.  This 

scale problem is even more extreme in an urbanized system where watershed boundaries 

are uncertain.  Municipalities add stormwater infrastructure (including structures which 

capture, convey, and discharge flow) as-needed, often without regard for the natural 

drainage patterns dictated by topography.  Storm-watersheds occur when stormwater 

infrastructure perforates municipal and watershed boundaries, creating man-made, “novel 

watersheds.”  Ecological impacts of stormwater runoff are difficult to assess.  Minimum 

Control Measure 3 (MCM3), of the SPDES Municipal Separate Storm Sewer Systems 

(MS4) Permit, addresses illicit discharge detection and elimination of stormwater 

pollution, but it is difficult to apply at a watershed scale (Brown et. al. 2004; NYS DEC 

2010).   

The objective of this study was to use a multi-criteria decision analysis to 

compare and contrast topographical watersheds and their storm-watershed counterparts.  

The storm-watersheds were created from mapped stormwater infrastructure and LiDAR 

data to more accurately determine drainage areas.  A multi-criteria index which evaluates 

the land’s biodiversity conservation value was also developed using a GIS and based on 

biodiversity conservation principles. The Kromma Kill, Dry River, and Salt Kill were 

selected as case studies to apply the model.  For each watershed, the size of the drainage 

area, the conservation values, and the amount of imperviousness were compared to the 

storm-watersheds.   

All of the storm-watersheds drain larger areas than their watersheds.  The 

Kromma Kill, Dry River, and Salt Kill storm-watersheds contained more land of lower 

biological value.  The Kromma Kill and Dry River storm-watersheds had more land with 

a higher imperviousness than their watersheds; the Salt Kill had less land with high 

amounts of imperviousness.  The differences between the watersheds and storm-

watersheds are enough to suggest using storm-watersheds to detect high priority 

conservation and restoration areas is a more accurate than using watershed boundaries.  
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1.  INTRODUCTION 

1.1  Federal and state stormwater regulations 

The Federal Water Pollution Control Act of 1948 was “the first major U.S. law to 

address water pollution” as a method of regulating pollutant discharges in to the waters of 

the United States (Andrews 2006; US EPA 2014); it was created to meet the challenge of 

how to properly treat our waterways.  Following amendments in 1977, the Act became 

known as the “Clean Water Act.”  The Clean Water Act (CWA) has been amended 

frequently over the years.  In the early stages, the Act required the regulation of point 

source discharges into United States waters (US EPA 2014).  With these new regulations, 

it became illegal to “discharge any pollutant from a point source into navigable waters 

unless a permit was obtained” (US EPA 2014).  Point sources are “discrete conveyances” 

like pipes or ditches which lead straight to waterbodies (US EPA 2014).  It includes 

wastewater from industries and sewage plants as well as from storm drainage from 

urbanized areas, collected runoff from construction sites, and runoff from some kinds of 

animal feedlots (US EPA 2014).  The National Pollutant Discharge Elimination System 

(NPDES) was created by the United Stated Environmental Protection Agency (EPA).  It 

is a permit program which regulates the amount of wastes that is eliminated into 

waterways (US EPA 2014).   

The 1977 amendments “recognized the need for planning to address the critical 

problems posed by nonpoint source pollution” (US EPA 2014).  Nonpoint source (NPS) 

pollution occurs when rainfall, snowmelt, or irrigation washes over the land as a “sheet 

flow” and picks up pollutants which ultimately end up in various waterbodies.  It can also 

end up in underground sources of drinking water (US EPA 2014).  Some examples of 
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NPS pollution that can be picked up and moved to waterways include bacteria, fertilizers, 

oil, sediment, and gross solids (NJ DEP 2012; SWC AC 2014; NYS DEC n.d.(b); US 

EPA 2014).    

Stormwater runoff is the largest contributor to NPS pollution (US EPA 2014).  

The Nationwide Urban Runoff Program (NURP) consisted of a series of studies and 

projects that were funded by the EPA which looked at the toxins present in NPS 

pollution.  Between 1978 and 1983, the EPA learned that stormwater had many of the 

same pollutants that were being regulated in industry discharges (US EPA 2014).  

Stormwater pollution is a water quantity and quality problem especially in urban and 

developing areas.  It is water that cannot infiltrate due to impervious surfaces so the rate 

of flow increases over the land and it is also picking up pollutants in the runoff.  It can 

modify the environment, sometimes causing habitat loss, increase flooding, decrease 

native wildlife, and increase sedimentation and erosion (US EPA 2013).       

The EPA mandated states to begin regulating stormwater runoff and prepare 

nonpoint source management programs.  The amendments were meant as a way to 

address water quality needs by building on EPA-state relationships (US EPA 2014).  

Phase I of stormwater pollution prevention started in 1990 (US EPA 2014).  This phase 

included large municipalities like New York city (the population is over 100,000 people), 

construction sites responsible for disturbing more than five acres of land, and industrial 

activities (US EPA 2014).  These groups had to develop a stormwater management 

program (SWMP).  In this way, run-off containing pollutants which made their way into 

waterways could be regulated on a more local level.         

Phase II of stormwater pollution prevention began in 1999 and included the 
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following groups: smaller municipalities like cities, towns and villages, schools and 

universities, and construction sites which were going to disturb more than one acre of 

land (US EPA 2014).  In New York State, two State Pollutant Discharge Elimination 

System (SPDES) permits were issued by the New York State Department of 

Environmental Conservation (NYS DEC n.d.(b)).  They are known as the “Phase II 

Stormwater Permits” (NYS DEC 2010).  The permits are required by the US EPA in 

order to meet the regulations regarding municipal stormwater in the CWA (NYS DEC 

2010).  One permit is called the “Construction Activity Permit” and the other is called the 

“Municipal Separate Storm Sewer Systems (MS4) Permit.”  Now, smaller and even more 

locally oriented municipalities and other industries had to develop a SWMP.  With this, a 

lot more of the country became regulated under the CWA. 

An MS4 is an “owner-operator of a municipal separated storm sewer system” 

(NYS DEC 2010).  A separated stormwater sewer system is not connected to a sewage 

treatment system; any of the water that enters this system goes directly to a stream or 

river without being treated (NYS DEC 2010).  This means that all of the runoff from 

lawns, paved surfaces, and erodible sites that goes into the stormwater drains ends up 

going directly into larger bodies of water.  There are no filtering or decontamination 

methods like there is in a sewer system carrying wastewater from homes (Higgins et. al. 

2005).   

As mandated in the MS4 permit, the municipalities involved are mandated to 

implement six minimum control measures (MCMs) (NYS DEC 2010).  MCM 3 accounts 

for the detection and elimination of stormwater pollution (Brown et. al. 2004; NYS DEC 

2010).  This minimal control measure requires municipalities to devise a way to 



4 

 

determine if there are any pollutants in the stormwater which is flowing into waterbodies.  

In order to do this, the permit requires three basic mapping products including: 1) 

stormwater outfall mapping, 2) drainage system network (infrastructure) mapping, and 3) 

sewershed (drainage area boundary) mapping (NYS DEC 2010) (Figure 1). 

 

1.2  Biodiversity and urban ecosystems 

Biological diversity, or biodiversity, can range from genetic variability within a 

species, to the composition of a landscape, to community-ecosystem diversity; it is the 

compilation of living things (Groom et. al. 2006).  Biodiversity is a major structural 

element of ecosystems.  In general, higher levels of biodiversity promote higher levels of 

ecosystem functioning (Dobson et. al. 1997; Nelson et. al. 2009; Slingenberg et. al. 

2009); humans derive many benefits from the services provided by intact biological 

systems (Polasky et. al 2005).  Even so, the loss of biodiversity is occurring at an 

accelerated rate due to the impacts of human activities which disturb community structure 

and ecosystems (Jenkins et. al. 2003).  Major anthropogenic threats to biodiversity 

include habitat loss (sometimes referred to as habitat conversion), climate change, over-

exploitation of natural resources, pollution of air and water, and introduction of invasive 

species (Groom et. al 2006; Slingenberg et. al. 2009).  Although all of these factors 

impact biodiversity, habitat loss is the most ecologically detrimental to terrestrial systems 

(Dobson et al. 1997; Jenkins 2003; Polasky et. al. 2005; Groom et al. 2006).  Humans 

induce habitat loss by using land for agriculture, extracting natural resources, and 

developing unnatural habitats, thereby, creating urban ecosystems (Dobson et al. 1997).   
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Urbanization is one of the leading types of land use change (Szlavecz et. al. 

2011).  Urban ecosystems, like any other ecosystem, contain interacting species and 

processes (Grimm et. al. 2000), are energy intensive, and are generally dependent on 

other ecosystems in order to function (Collins et. al. 2000); natural ecosystem functions 

are interrupted by urban development.  With respect to stormwater management, some of 

these ecosystem disruptions include the removal of vegetation which slowed and 

absorbed water and the leveling of natural depressions which temporarily pooled or 

stored water so it could infiltrate.  Rooftops, roads, parking lots, and other impervious 

surfaces which are constructed do not allow precipitation to soak into the ground (CWP 

2003).  As a result of the increase in imperviousness, the amount of stormwater runoff 

also increases (CWP 2010). 

Stormwater drains downhill due to gravity within a drainage area; it flows into 

stormwater structures which can capture (i.e. catch basins) and then convey the 

stormwater through underground pipes (i.e. main lines).  This degrades the habitat for 

plants and animals which depend on clear water in many ways: 1) stormwater runoff 

within stormwater infrastructure is concentrated through its conveyance system where it 

moves faster and in a larger volume thereby increasing its erosional ability and potential 

to disrupt aquatic habitats, 2) the stormwater runoff carries sediment that does not have 

an opportunity to settle out, so the sediment from eroded stream banks clogs fish gills and 

blocks light needed for plants and settles and fills stream channels and other waterbodies 

which can increase flooding, 3) the water is usually higher in temperature from 

impervious areas which can harm aquatic ecosystems, 4) less infiltration is possible 

(unless the infrastructure is punctuated by detention areas like ponds or wetlands), so 
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aquifers are not recharged adequately, and 5) urbanized areas increase the amount of 

pollutants carried to waterbodies which can harm aquatic life and degrade drinking water 

(US EPA 2003; NJ DEP 2012).   

 

1.3  Traditional watershed-based conservation and planning  

Stormwater management is a crucial problem in most urbanized areas, but 

stormwater infrastructure is often obscure and not well-accounted for in urban ecosystem 

research.   When determining a relevant scale for ecosystem research and planning, the 

natural topologically delineated watershed boundary has been used widely (Schueler 

1994; Arnold & Gibbons 1996; Brabec et al. 2002; CWP 2003; US EPA 2003).  This is 

the total land area, based on topography, which drains directly into a particular channel or 

waterbody (Groom et. al 2006; NJ DEP 2012).  It is a fundamental ecological unit 

applied to water quality research and urban natural resource conservation.  According to 

the U.S. Environmental Protection Agency (EPA), environmental management using a 

watershed approach constitutes “a coordinating framework for environmental 

management that focuses public and private sector efforts to address the highest priority 

problems within hydrologically defined geographic areas” (Tim and Malavaram 2003).  

One of the most commonly known watershed analysis tools refers to the Impervious 

Cover Model (ICM) (CWP 2003) (Figure 2).   

The ICM suggests that once a watershed becomes more than 10% impervious, it 

is more likely to be impaired for both aquatic and terrestrial life (CWP 2003).  This same 

threshold at the watershed level has also been found in other studies resulting in a similar 

predictor model (Schueler 1994; Arnold & Gibbons 1996; Brabec et al. 2002; US EPA 
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2003).  Likewise, most urban populations of wild species are structured in part by 

watershed properties, so using a watershed as boundary to study biodiversity is logical.    

  

1.4  The benefits of storm-watershed based conservation and planning  

A topographically delineated watershed boundary can traverse multiple 

municipalities and can also be perforated by the stormwater infrastructure of the 

respective watershed (Figure 3).  Humans alter watersheds by changing how and where 

stormwater flows, including the addition of artificial drainage infrastructure (NJ DEP 

2012).  Stormwater infrastructure is used to carry runoff from rooftops and paved areas to 

nearby waterbodies (US EPA 2003), and can bypass infiltration opportunities altogether 

(Tran et. al. 2010).  Traditional watersheds do not include stormwater infrastructure or 

address intermunicipal drainage patterns.  This situation became apparent during the 

stormwater infrastructure mapping project which was conducted in Albany County, NY.  

Specifically, stormwater infrastructure owned by the Town of Colonie within the Salt 

Kill watershed drains into the City of Watervliet infrastructure and discharges into the 

Dry River (Figure 4).   

Rather than continuing to use watershed boundaries to conduct research for 

resource conservation and biodiversity conservation, a modified boundary (according to 

the stormwater infrastructure) can be used in an effort to more accurately represent the 

drainage area; it is called a storm-watershed (Figure 5).  By using storm-watersheds, all 

of the land draining into a particular stream or other waterbody is accounted for.  In this 

way, a storm-watershed more accurately represents the different land use types and 

pollutants draining to a waterbody within an urbanized environment, compared to what is 
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represented in the topographically delineated watershed.  The ecosystem delineated from 

the storm-watershed may function differently than that of the topographically delineated 

watershed and may also be composed of different organisms; this may alter the 

biodiversity composition of the newly-designated ecological unit and change how the 

urban watershed is managed.  

 

1.5  Prioritizing areas for conservation and restoration  

Habitat conversion and the loss of biological diversity seems to be inevitable in an 

urbanized area.  In response to this, conservation and restoration practices need to be 

implemented strategically, at an accurate scale and rational locations.  Fundamental 

practices which could be used for a biodiversity conservation plan in an urban 

environment include 1) setting aside unaltered land as parks and nature preserves to 

safeguard sufficient habitat and support viable populations (Meyerson 2009), and 2) 

restoration of degraded habitats where possible (Hudsonia 2001; Dobson et. al. 2007).  

Many studies have used GIS (Tim & Mallavaram 2003; Liu et. al. 2007; Theobald & 

Hobbs 2002; Theobald 2007; Nelson et. al 2009) and, specifically, multi-criteria decision 

analyses for conservation purposes (Kiker et. al. 2005; Phua & Minowa 2005; Giordano 

& Reidel 2008; Van Dyke 2008); surrogate criteria have served as biodiversity indicators 

(Van Dyke 2008; Vizzari 2011).   

 

1.6  Study objectives 

The purpose of this study was to find an accurate scale and a way to locate areas 

for biodiversity conservation and ecological restoration for the Kromma Kill, Dry River, 
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and Salt Kill drainage areas in Albany, NY.  These waterbodies were chosen because 

they are on the New York State Section 303(d) List of Impaired/TMDL Waters; the list 

identifies those waters that do not support appropriate uses based on their water 

classification and require some kind of restoration strategy (NYS DEC 2014).  This study 

specifically challenges the use of the topographically-delineated watershed as the optimal 

unit for demarcating conservation studies within an urban environment and suggests that 

a storm-watershed boundary be used as a more accurate representation of in the full 

physical and ecological properties of a catchment area.  This study also utilizes a multi-

criteria decision analysis within a GIS to prioritize land for the conservation of 

biodiversity by using surrogate criteria as biodiversity indicators, to test whether the 

storm-watershed concept can have practical conservation value.  

Research goals: 

1. To determine if there are size differences between the topographically delineated 

watershed boundaries and their storm-watershed counterparts for the Kromma 

Kill, Dry River, and Salt Kill. 

2. To determine if there are composition differences (based on the multi-criteria 

analysis model) between the topographically delineated watershed boundaries and 

their storm-watershed counterparts for the Kromma Kill, Dry River, and Salt Kill. 

3. To create a GIS-based tool to be used for future conservation and restoration 

purposes. 

Research objectives:  

1. Delineate storm-watersheds for the Kromma Kill, Dry River, and Salt Kill.  

A. Map stormwater infrastructure 
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B. Use LiDAR data to determine catchment areas for waterbodies based on 

stormwater infrastructure 

2. Create a GIS-based multi-criteria analysis model based on criteria for biodiversity 

conservation. 

A. Determine which criteria are important for the conservation of biodiversity 

B. Find GIS data for these criteria 

C. Create a conservation planning model   

3. Compare the size of the drainage areas of the topographically delineated 

watershed boundaries to their storm-watershed counterparts for the Kromma Kill, 

Dry River, and Salt Kill. 

4. Compare the composition of the topographically delineated watershed boundaries 

to their storm-watershed counterparts for the Kromma Kill, Dry River, and Salt 

Kill based on their contributions to biodiversity. 

5. Determine if watersheds or storm-watersheds are more appropriate for 

conservation and restoration planning.   

6. Determine and elucidate any constraints to the model. 

7. Discuss the legal and political frameworks needed to address successful 

conservation and restoration projects in the Kromma Kill, Dry River, and Salt 

Kill.  
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Figure 1.  Excerpt from NYSDEC SPDES GP-0-10-002 (pg. 34 and 55).  For Minimum 

Control Measure 3: Illicit Discharge Detection and Elimination, MS4s must map their 

stormwater infrastructure in order to be in compliance with the Permit.  

 

 

 
Figure 2. Impervious Cover Model (CWP 2003).  This model refers to a prediction model 

for water quality which uses a watershed as its scaling unit.   
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Figure 3. a) A watershed.  The grey arrows indicate direction of flow of the water.  The 

grey circle indicates a hydraulic junction. b) An intermunicipal watershed.  The same 

watershed crosses over municipal boundaries.  c) Stormwater infrastructure as it 

perforates a watershed boundary.  The arrows on the main lines indicate direction of 

flow.  d) Stormwater conveyance system structures.   
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Figure 4. Conceiving “storm-watersheds.” a) The MS4 regulated area in Albany County, 

NY.  b) Stormwater system mapping by MS4.  c) Integration of stormwater system 

mapping exposes stormwater infrastructure which crosses watershed and municipal 

boundaries. 

 

 

 
Figure 5. Delineation of a “storm-watershed.” a) Additional land area draining into a 

watershed based on the location of intermunicipal stormwater infrastructure.  b) A 

“storm-watershed” delineation accounting for infrastructure.   
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2.  STUDY AREA 

In compliance with the NYSDEC SPDES Permit and assisted by a NYS DEC 

Environmental Protection Fund Water Quality Improvement Project grant, the 

Stormwater Coalition of Albany County mapped sections of the MS4 stormwater 

infrastructure within Albany County, New York from December 2012 to July 2013 

(Figure 6).  Three watersheds within the MS4 area were chosen by the Stormwater 

Coalition of Albany County as the locations to complete the stormwater infrastructure 

mapping and were subsequently used as the study areas for this project: Kromma Kill, 

Dry River, and Salt Kill (Figure 7).  
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Figure 6. a) Albany County, New York.  b) Albany County municipalities and associated 

MS4 area. 

 

 
Figure 7. The Kromma Kill, Dry River, and Salt Kill watersheds.  The watershed 

delineations were created using an online mapping system designed by USGS called 

StreamStats.   
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3.  PART I: STORMWATER INRFRASTRUCTURE MAPPING AND  

DEVELOPING STORM-WATERSHEDS 

3.1  Mapping stormwater infrastructure 

Preexisting municipal stormwater infrastructure data (i.e. paper maps and 

geographic information system (GIS) data) were inventoried.  Typical structures used to 

convey stormwater were identified for further analysis, and the stormwater infrastructure 

mapping project by Herkimer-Oneida Counties was reviewed as it was completed in 

compliance with the same parts of the NYSDEC SPDES Permit (SWC AC 2013).  An 

initial list of common features and attributes of all system maps was compiled.  A data 

model, the stormwater infrastructure to be mapped, associated attributes, and coding for 

domains were assembled within a file geodatabase in ESRI ArcGIS10.1 by the 

Stormwater Coalition of Albany County (SWC AC) GIS Technician (SWC AC 2013) 

(Figure 8).  Input from all members of the SWC AC, local GIS consultants, and GPS 

consultants was employed to create the data model.   

Existing map data were used when possible and loaded into individual municipal 

file geodatabases following the data model.  If there was no existing data or the data were 

not accurate, areas were mapped or re-mapped using GPS and GIS technology.  To map 

the stormwater infrastructure with GPS, the same stormwater infrastructure data model 

was used to create a data dictionary using Pathfinder Office 5.1 (SWC AC 2013).  The 

data dictionary was loaded onto the GPS unit, Trimble Yuma Tablet with Pro XH 

Receiver, which had TerraSync 5.1 software.  As needed, stormwater infrastructure 

draining into the prioritized watersheds was mapped.  The data were collected, managed, 

and post-processed by the GIS Technician (SWC AC 2013).   
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All the data were then moved into municipally appropriate file geodatabases.  The 

data underwent a series of checks including integrity and topological checks and was 

processed consistently (using ESRI Arc Info 10.1). A base map was created using various 

data to analyze the stormwater infrastructure and facilitate the editing process (SWC AC 

2013).  A final, intermunicipal meeting was held after the data were collected to 

determine the appropriate ownership of stormwater structures which were mapped on 

municipal boundaries.  The stormwater infrastructure for each of the prioritized 

watersheds was mapped (Figures 9, 10, and 11).  

 

3.2  Developing storm-watersheds 

The edited stormwater infrastructure data were then used as a starting point to 

create storm-watersheds.  The catch basins associated with a particular waterbody were 

located using the “Priority Watershed” attribute (i.e. all catch basins which drained to the 

Kromma Kill were selected).  LiDAR data were then used in conjunction with the 

infrastructure data to create flow direction and accumulation grids for the catch basins 

draining to the same waterbody.  The drainage areas that were produced for each catch 

basin were converted to polygons for each of the individual watersheds and merged with 

the existing topographically delineated watershed boundaries to create the storm-

watersheds (SWC AC 2013) (Figure 12). 

 

3.3  Watershed and storm-watershed comparison 

Once the storm-watersheds were created, they were mapped with their watershed 

counterparts (Figures 13, 14, and 15). Visually, the storm-watersheds look different than 
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their associated watersheds; some of the drainage area that was included in the watershed 

is not included in the storm-watershed and vice versa.  All of the storm-watersheds drain 

larger areas than their watersheds (Table I).    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



19 

 

 

Figure 8. a) A basic stormwater conveyance system used to discuss features to include in 

the data model.  b) The GIS features chosen to map, the type of feature, and how each 

was defined for the data model.   

 

 
Figure 9.  Map of the stormwater infrastructure data that were collected for the Kromma 

Kill watershed. 
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Figure 10. Map of the stormwater infrastructure data that were collected for the Dry 

River watershed.  
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Figure 11. Map of the stormwater infrastructure data that were collected for the Salt Kill 

watershed. 
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Figure 12.  The Kromma Kill, Dry River, and Salt Kill storm-watersheds.  The storm-

watersheds were created using LiDAR.   
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Figure 13. A map of the topographically delineated watershed and LiDAR derived storm-

watershed of the Kromma Kill. 
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Figure 14. A map of the topographically delineated watershed and LiDAR derived storm-

watershed of the Dry River.  
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Figure 15. A map of the topographically delineated watershed and LiDAR derived storm-

watershed of the Salt Kill.  

    

 

Table I.  The sizes of the drainage areas for each prioritized waterbody’s watershed and 

storm-watershed.   

 

 

 Prioritized Waterbody 

 
Kromma 

Kill 
Dry River Salt Kill 

Drainage Area  

(sq. km) 

Watershed 18.82 11.76 10.63 

Storm-

watershed 
19.03 12.32 10.72 

Difference  +0.21 +0.57 +0.10 
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4.  PART II: HIGH PRIORITY CONSERVATION AREA (HPCA) MODEL  

As was suggested in Part I, the watersheds and storm-watersheds could have 

potential differences in their drainage.  A weighted arithmetic model was created in 

ArcGIS 10.1 and the Spatial Analyst extension.  This model was comprised of publically 

available geospatial data used to represent terrestrial areas that may have important 

biological components of ecosystems that promote biodiversity or have high potential for 

conservation of biodiversity (Kiker et. al. 2005; Phua & Minowa 2005; Valente & 

Vettorazzi 2008).  This high priority conservation area (HPCA) model was derived from 

eight criteria to identify areas of high biological value for conservation of biodiversity.  

All the data were projected into NAD 83 UTM Zone 18N.  Vector and raster data were 

used.  The criteria included: presence of wetlands, distance to protected areas 

(connectivity), distance to roads, distance to riparian areas, amount of impervious 

surface, and presence of forests.   

 

4.1  Criteria rationale  

Each criterion was ranked based on its biological value from 0 (least valuable) to 

3 (most valuable) (Table II); this same ranking was used to reclassify the criteria in 

ArcGIS 10.1 (Figure 16). 

4.1.1  Wetlands 

Wetlands are important features of ecosystems that provide many services to the 

surrounding environment.  They provide flood control by temporarily holding and storing 

floodwaters, cleanse and supply water, absorb nutrients from fertilizer runoff, maintain 

year-round base flow to streams, and remove sediment from surface runoff (US EPA 
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2001; Groom et. al. 2006; Thigpen 2006).  Additionally, they provide wildlife habitat, 

with 45% of threatened and endangered species relying directly or indirectly on wetlands 

for long-term survival (Chiras 2001). Comparable to tropical rainforests and coral reefs 

(US EPA 2001), they act as permanent habitat for a diversity of species (Chiras 2001; 

Thigpen 2006; Woodward & Wui 2001).  This criterion was quantified in the model as 

presence or absence of wetland features (i.e. If wetlands were present, they were given a 

value of 3).    

4.1.2  Distance to protected areas 

Habitat fragmentation is arguably the leading cause of biodiversity loss at a global 

scale (Groom et. al. 2006).  This is especially true in upstate New York where 

development and habitat conversion are quickly outpacing population growth, causing 

urban and rural sprawl (Pendall 2003).  Limited connectivity between patches can impact 

a species genetic variability, the amount of space a species needs, the ability for certain 

species to find hospitable habitats as climate change alters the ranges of natural habitats 

(Groom et. al 2006), and overall species diversity (Robinson & Quinn 1992; MacArthur 

and Wilson 1967, cited in Minor et. al. 2009).  Previous studies have indicated that 

distances up to 500 meters between protected areas are considered to be contiguous 

(Chomitz et al. 2006); this was the basis for including and ranking the distance to an 

already protected area in the model.  

4.1.3  Distance to roads 

Impervious surfaces, including roads, are components of an urbanize area’s 

infrastructure that are impenetrable by water.  Networks of roads can increase the amount 

of erosion and stormwater runoff in an area, degrading local stream quality (Forman & 
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Alexander 1998).  Roads can be sources of nonpoint pollution and can affect water and 

soil quality (Forman & Alexander 1998; Hasse & Lathrop 2003).  Posing a direct impact 

on animals, roads cause animal mortality from road construction and vehicle collisions 

(Trombulak & Frissell 2000, cited in Groom et. al. 2006; Fahrig & Rytwinski 2009).  

Roads alter the landscape spatially and can function as barriers to ecological flows, 

mainly the movement of a species from one habitat patch to another (Forman & 

Alexander 1998; Trombulak & Frissell 2000, cited in Groom et. al. 2006).  Interior 

species are greatly impacted by roads, which increase the fragmentation of a landscape 

and edge effects (Forman & Alexander 1998; Laurance et al. 2002).  A distance of 100 

meters from roads has suggested to maintain species richness, yet widths as low as 60 

meters can potentially protect against some disturbances.  The buffer widths chosen for 

the model account for this “road-effect zone” (Forman et. al. 1997).   

4.1.4  Distance to riparian areas 

Riparian zones are generally vegetation buffers around streams and rivers that aid 

in bank stabilization (USDA 1998; Rosgen 2001, cited in Tran et. al. 2010; Thigpen 

2006), reduce erosion and runoff of sediment and nutrients, remove pollutants from water 

runoff, provide mixes of terrestrial and aquatic habitats, connect populations, and provide 

flood control (USDA 1998; Bentrup 2008; NYS DEC & NYS DOS 2004).  Disturbing 

the physical habitat surrounding an aquatic environment contaminates habitat for 

invertebrate communities as much as other sources of pollution (NYS DEC 2009).  

Generally, high riparian vegetation cover means that the stream or river will be more 

protected from worst impacts of non-point-source contamination (Thigpen 2006).  A 

stream buffer can provide the necessary space for maintenance of biological processes 
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and species richness.  While functional wildlife habitat is represented in riparian buffers 

as narrow as 25 meters, the greatest biodiversity will be encompassed in areas greater 

than 200 meters.  This amount of area also promotes the water cleansing functions of 

riparian buffers as well (USDA 1998).  For use in the model, distances to riparian areas 

were incorporated (USDA 1998; Bentrup 2008; NYS DEC & NYS DOS 2004).    

4.1.5  Impervious surfaces 

Impervious surfaces are urbanized locations with man-made infrastructure that 

prevents percolation and natural nutrient processing due to loss of contact with soils.  

Impervious areas increase the risks of flooding, erosion, and sediment loading in streams 

(Thigpen 2006), act as sources of nonpoint pollution and otherwise degrade water quality 

(Hasse & Lathrop 2003).  Studies suggest that water quality, and, subsequently, stream 

health and biodiversity, decline when impervious cover exceeds 10% to 15% in 

urbanized catchments (Schueler 1994; Arnold & Gibbons 1996; Brabec et al. 2002; CWP 

2003; US EPA 2003).  For the model, the amount of impervious surfaces was based on 

the range of imperviousness as defined by the NLCD 2006 Percent Developed 

Imperviousness (Multi-resolution Land Characteristics Consortium 2006).  The land 

cover data include a variety of land cover classes including different types of developed 

land (open space, low intensity, medium intensity, and high intensity).   

4.1.6  Forests 

Forested lands are important components of the natural mosaic of landscapes in 

upstate New York and in global communities.  Forests of all life stages provide important 

habitats for a wide array of organisms (Hansen et al. 1991) especially stream biota 

(Harding et. al. 1998) and contribute to important ecosystem processes (e.g. 
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biogeochemical cycles, carbon sequestration, and water filtration) (Groom et al. 2006).  

Forests become fragmented by the addition of roads, subdivision of properties, and the 

addition of other infrastructure; this increases edges and, consequently, the perimeter to 

area ratio.  Edges have been shown to attract common species that may out-compete 

more vulnerable species, along with creating opportunities for invasive species 

establishment (Laurance et al. 2002; Groom et al. 2006).  These “edge effects” have been 

shown to penetrate into the core habitat, decreasing suitable habitat for many species 

(Laurance et al. 2002) and disrupting the normal functions of communities (Robinson & 

Quinn 1992).  Forested lands are quantified in the model as present or absent because of 

their wide range of benefits. 

 

4.2  HPCA model construction 

These ranked criteria were then used to create a weighted arithmetic model; a 

score was assigned to each criterion (represented by a layer in a GIS) and the scores were 

totaled, resulting in a model with values from 0 to 18 (Theobald 2007).  For purposes of 

this study, no weights were assigned (i.e. none of the criteria were valued more than 

another) as might be the case with stakeholder input (Liu et. al. 2007; Theobald 2007).  

The model was reclassified to reflect the 0 (least valuable) to 3 (most valuable) ranking 

used throughout the study (Figure 17) using equal intervals.  From the reclassified model, 

the existing protected areas in Albany County were removed because the aim was to 

delineate potential targets for conservation and restoration.  This final iteration became 

known as the high priority conservation area (HPCA) model (Figure 18) (Appendix A).   
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4.3  HPCA model comparison 

Both watersheds and storm-watersheds were applied to the HPCA model to 

determine the biological value of the land in each (Figures 19, 20, and 21).  The value of 

the land was analyzed.  According to Table III, the Kromma Kill storm-watershed had an 

increase in drainage area from the land valued at 0 and no change in the land valued at 2 

or 3 compared to its watershed, the Dry River storm-watershed had an increase in 

drainage area from the land valued at 0 and no change in the land valued at 2 or 3 

compared to its watershed, and the Salt Kill storm-watershed had a decrease in the land 

valued at 0, an increase in the land valued at 1, and no change in the land valued at 2 or 3 

compared to its watershed.  In general, the storm-watersheds were draining more land 

area of lower biodiversity conservation value than was predicted by the topographically-

determined watersheds. 

 

4.4  Imperious surface comparison 

 Impervious surfaces are widely used as a preliminary diagnosis for water quality.  

With that in mind, the impervious surfaces criterion was analyzed on its own for changes 

in biological value between the watersheds and storm-watersheds.  More specifically, the 

10% imperviousness threshold as discussed in previous studies was examined (Figures 

22, 23, and 24) (Table IV).  For both the Kromma Kill and the Dry River, there was an 

increase in the amount of land with more than 10% imperviousness.  Both waterbodies 

also saw an increase in the amount of land with less than 10% imperviousness (in parallel 

with the increase in total drainage area).  The Salt Kill drainage area showed a decrease 



32 

 

in the amount of land with more than 10% imperviousness and an increase in the amount 

of land with less than 10% imperviousness.       
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Table II. The criteria used to represent biodiversity.  Values have been assigned to 

wetlands, distance to protected areas, distance to roads, distance to riparian areas, 

impervious surfaces, and forests based on their biological values.  0= least biologically 

valuable; 3= most biologically valuable. 

 

  Value 

Criterion 0 1 2 3 

Wetlands Absent   Present 

Distance to 

protected areas 
> 800 meters 400– 800 meters < 400 meters Adjacent 

Distance to roads ≤ 50 meters 50 – 100 meters 
100 – 200 

meters 
> 200 meters 

Distance to 

riparian areas 
> 76 meters 76 – 53 meters 53 – 30 meters < 30 meters 

Impervious 

surfaces 
> 35% 10% – 35% 5% – 10% < 5% 

Forests Absent   Present 

 

 

 

 
Figure 16. Criteria maps for Albany County using their assigned biological value: a) 

wetlands, b) distance to protected areas, c) distance to roads, d) distance to riparian areas, 

e) amount of impervious surfaces, and f) presence of forests.   
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Figure 17. a) The weighted arithmetic model.  b) The reclassified model.  

 

 

 
Figure 18. a) The reclassified model. b) The high priority conservation area (HPCA) 

model.  The black circles indicate some lands that were already protected (white, 

compared to the reclassified model).  
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Figure 19. The HPCA model within the Kromma Kill watershed and storm-watershed.  
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Figure 20. The HPCA model within the Dry River watershed and storm-watershed. 
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Figure 21. The HPCA model within the Salt Kill watershed and storm-watershed. 

 

 

Table III. The sizes of the drainage areas for each prioritized waterbody’s watershed and 

storm-watershed broken out by its HPCA model value.   

   
Prioritized Waterbody 

Kromma Kill Dry River Salt Kill 

  HPCA Value 0 1 2 3 0 1 2 3 0 1 2 3 

Drainage Area   

(sq. km) 

Watershed 11.23 6.63 0.88 0.02 7.82 3.09 0.72 0.01 6.51 3.13 0.95 0.02 

Storm-watershed 11.5 6.57 0.88 0.02 8.29 3.14 0.72 0.01 6.5 3.23 0.96 0.02 

Difference +0.26 -0.06 0.00 0.00 +0.48 +0.05 0.00 0.00 -0.02 +0.1 0.00 0.00 
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Figure 22. The impervious surfaces criterion within the Kromma Kill watershed and 

storm-watershed. 

 
Figure 23. The impervious surfaces criterion within the Dry River watershed and storm-

watershed. 
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Figure 24. The impervious surfaces criterion within the Salt Kill watershed and storm-

watershed. 

 

 

Table IV. The sizes of the drainage areas for each prioritized waterbody’s watershed and 

storm-watershed broken out by land with more than 10% imperviousness and less than 

10% imperviousness.   

   Prioritized Waterbody 

  Kromma Kill Dry River Salt Kill 

  Amount of 

Imperviousness 
>10% <10% >10% <10% >10% <10% 

Drainage Area 

(sq. km) 

Watershed 7.31 11.49 6.1 5.66 5.42 5.19 

Storm-watershed 7.47 11.55 6.52 5.8 5.35 5.36 

Difference +0.16 +0.05 +0.43 +0.14 -0.08 +0.16 
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5.  DISCUSSION 

5.1  Implications of comparing watersheds to storm-watersheds  

Storm-watersheds can be a more accurate ecological unit for studies of water 

quality and biodiversity conservation.  This study exposed differences between watershed 

and storm-watershed delineations that imply a variety of consequences:  

1. A change in the volume of water draining to a particular waterbody. 

2. A change in the types of pollutants within a drainage area.  

3. A change in the value of the land for biodiversity conservation within the 

catchment.  

4. A change in the predicted water quality of the receiving water.  

This study suggests that the Kromma Kill, Dry River, and Salt Kill 

stormwatersheds are receiving a larger volume of water, potentially more NPS pollutants, 

and have more land that is less biologically diverse than the hydrologically delineated 

watersheds.  The storm-watershed delineation predicts that the receiving waters are 

experiencing more biologically harmful impacts than are predicted by its watershed-

based analysis and have more land that is not suitable for biodiversity conservation.      

In using the storm-watershed ecological unit, this study also suggests that the 

Kromma Kill and Dry River have lower water quality than was predicted by the 

watershed delineation using the criterion of the amount of imperviousness within the 

drainage area.  Conversely, the Salt Kill storm-watershed has higher water quality than 

was predicted by the watershed delineation.  A large portion of the City of Watervliet that 

appears to drain to the Salt Kill according to the topographically delineated watershed 

actually drains to the Dry River in the storm-watershed approach (Figures 13 and 14).  
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Although this does not necessarily account for the entire difference, it is one of the most 

egregious instances of the potential differences between watersheds and storm-

watersheds.  Even so, all three waterbodies are on the New York State Section 303(d) 

List of Impaired/TMDL Waters (NYS DEC 2014).  This outcome is valuable as a way to 

reinforce the need for further water chemistry and other water quality tests (i.e. benthic 

macroinvertebrate sampling conducted by the NYS DEC) which are needed to place a 

waterbody on the 303(d) list as opposed to solely relying on prediction models.     

None of the prioritized waterbodies experienced a decrease in the amount of 

highly valued land for biodiversity conservation when the watersheds and storm-

watersheds were compared.  It is possible, for the storm-watershed delineations, that the 

HPCAs were the same geographic locations as those present in the watersheds.  

However, it is also possible that equivalent amounts of highly valued land were 

exchanged between adjacent watersheds and storm-watersheds.  This would 

d require further analysis and ground truthing as the HPCA model was designed not to 

discriminate between where the HPCAs are located, it only delivers a value on the land 

for biodiversity.   

 

5.2  Storm-watershed constraints and the importance of intermunicipal 

collaboration  

As was suggested by the HPCA model, none of the prioritized waterbodies 

experienced a decrease in the amount of highly valued land for biodiversity conservation, 

only in an increase in the amount of less biologically valuable land.  This implies that 

storm-watersheds are always larger than their watershed counterparts, but that cannot be 
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the case since there is a finite amount of drainage area.  The issue here is that the 

surrounding stormwater infrastructure was not mapped; storm-watersheds were not 

created for the surrounding waterbodies.  That said, it is possible that adjacent storm-

watersheds are smaller than their watershed complement.  

Even though these three storm-watersheds were created based on the drainage of 

water to stormwater infrastructure, there is a possibility that the storm-watersheds could 

change slightly based on the drainage patterns represented in adjacent storm-watersheds, 

especially around the edges of the boundaries.  This is because, in the absence of 

stormwater infrastructure draining to one of the prioritized waterbodies, the model 

defaulted to the topographically delineated watershed.  If there is a catch basin near the 

edge of one of the storm-watersheds that drains to a neighboring waterbody, that 

catchment area would not be accounted for in the creation of the storm-watersheds until 

the neighboring waterbody’s storm-watershed was created.  

Similarly, these storm-watershed maps were created from data that became 

available through the Stormwater Coalition of Albany County.  Unfortunately, 

stormwater infrastructure data from MS4s which are not a part of the Stormwater 

Coalition were not included.  The most pronounced example of this issue became 

apparent in the Dry River and Salt Kill storm-watershed delineations (Figures 14 and 15).  

There is a line-like portion of the Salt Kill storm-watershed which perforates the Dry 

River storm-watershed.  This “line” is exactly where State Route 7 runs; this anomaly is 

likely due to missing stormwater infrastructure data from the New York State Department 

of Transportation.  



43 

 

Combined sewer overflow (CSO) infrastructure data was also not considered 

during the creation of storm-watersheds.  CSO infrastructure, like stormwater, is also 

made up of catch basins, manholes, and main lines, but ultimately brings stormwater 

runoff to wastewater treatment facilities after it combines with sanitary infrastructure 

(NYS DEC n.d.(a).  In this way, it is possible that CSO catch basins were present within 

the storm-watersheds, but the land draining to those particular catch basins was not 

removed from the new delineation.  This would be particularly important for both the Dry 

River and the Salt Kill drainage areas which contain CSOs.        

Funding for stormwater regulatory requirements is largely left up to the 

responsibility of the MS4 and grant funding.  The stormwater infrastructure mapping 

portion of this project was funded and completed by municipally employed staff (time 

and knowledge of infrastructure) and the NYS DEC Environmental Protection Fund 

Water Quality Improvement Project grant (used to hire the GIS technician) that the 

Stormwater Coalition of Albany County received.  Once the grant ended and the GIS 

technician left, the MS4s were left on their own to complete the stormwater infrastructure 

mapping.  Unfortunately for most MS4s, there is not a dedicated stormwater staff to 

complete this task (SWC AC 2013).  The Stormwater Coalition of Albany County 

periodically supplies assistance with this regulatory requirement, but not in any capacity 

comparable to the effort put forth during the peak of the grant.  Although the stormwater 

infrastructure of catchment areas adjacent to the Kromma Kill, Dry River, and Salt Kill 

are mandated by the Permit to be mapped, they are not likely to be mapped with the same 

efficiency or storm-watershed based approach due to funding constraints.  Therefore, 

possible uncertainties around the storm-watershed edges may not be rectified.     
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Storm-watersheds and watersheds have one important commonality: they are not 

constrained by political boundaries.  Uncertainties in storm-watershed delineations due to 

missing data cannot be resolved until all MS4s have mapped their stormwater 

infrastructure.  Even though the MS4s in the Stormwater Coalition of Albany County are 

owned and managed independently, there was strong underlying inter-municipal 

collaboration to complete the stormwater infrastructure mapping and the Coalition 

functions as a shared service throughout MS4s in Albany County (SWC AC 2013).  This 

lead to more accurate catchment delineations.  Likewise, biodiversity conservation 

demands collaboration across political boundaries to meet landscape and ecosystem scale 

needs.  As Miller (1996) stated, “biodiversity will be retained to the extent that whole 

regions are managed cooperatively among protected areas, farmers, foresters, and other 

neighboring land users” (cited in Polasky et. al. 2005).  This study showed that this kind 

of work is possible though the Stormwater Coalition of Albany County. This kind of 

cooperation will be needed between MS4s, counties, states, etc. in order to yield 

complete and viable storm-watershed delineations and appropriately conserve land for 

biodiversity.     

 

5.3  HPCA model constraints and the importance of stakeholders 

The HPCA model indicates locations biologically valuable land that could be 

added to the local conservation portfolio.  However, the underlying model treated each 

criterion as equally valuable.  This decision could be challenged on ecological grounds.  

For example, it is possible that more value can be assigned to riparian areas in 

comparison to the other criteria.  If this revised model was then applied to the watershed 
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and storm-watershed delineations, the difference seen in the amount of highly valued 

land could increase.  On the other hand, weighting the criteria would in many ways need 

support, including political support, and further iterations would benefit from stakeholder 

input.  

Many studies discuss the interaction between the social and natural sciences to 

properly implement a conservation plan (Grimm et. al. 2000; Margules & Pressey 2000; 

Theobald & Hobbs 202; Szlavecz et. al. 2011; Hager et. al. 2013).  Stakeholders for local 

land use planning can include government officials, concerned citizens, and biologists; 

they create conservation goals, refine spatial modeling processes, and help implement 

conservation strategies (Theobald & Hobbs 2002).  This type of support and input would 

be necessary to develop successful conservation and restoration plans based on the HPCA 

model.             

 

5.4  Future directions: Stormwater management for biodiversity conservation and 

restoration 

Stormwater infrastructure is designed to manage stormwater in urbanized areas, 

however, the once natural ecosystems are sufficiently altered, structurally and 

functionally, to qualify as novel ecosystems (Seastedt et. al. 2008).  Developing more 

realistic models of urban ecological systems will result in more successful solutions to 

environmental problems (Grossmann 1993, cited in Grimm et. al. 2000).  This was a 

preliminary study used to find differences and similarities between watersheds and storm-

watersheds.  In junction with storm-watersheds, the HPCA model more precisely 

determines the biological value of land in an effort to locate more appropriate areas for 
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conservation and restoration purposes.  The next step in the process would be to use the 

HPCA model to 1) locate areas of high biological value and preserve them and 2) find 

locations with good potential for biological restoration.   

This ecological retrofit and restoration approach implies the incorporation of 

green infrastructure practices.  Green infrastructure includes some of the following: using 

vegetation to stabilize soils, building retention ponds to slow water through stormwater 

systems in an attempt to let water infiltrate, conserving open space, reducing 

imperviousness, slowing down stormwater runoff, or preserving plants or planting trees 

in a developed area (i.e. green roofs) (Thigpen 2006; CWP 2010).  Urban runoff can also 

be managed by minimizing contaminants in the runoff (i.e. not using fertilizers or 

pesticides, picking up after pets, sweeping up sidewalks and roads, etc.) (US EPA 2003).   

Thigpen (2006) suggests that stream related problems caused by watershed-wide 

issues can be addressed by properly capturing and managing stormwater runoff before it 

reaches a specific waterbody.  A similar strategy can now be applied at the storm-

watershed level in an effort to conserve biodiversity (this includes aquatic biodiversity 

associated with the stream).  Capturing and managing stormwater runoff within the 

storm-watershed could promote a more biologically diverse drainage area in the same 

way.  This technique is also what is suggested by MCM 5 post construction runoff 

control and would further assist MS4s with stormwater regulation compliance (NYS 

DEC 2010).     
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Appendix A:  

GIS process steps to create the high priority conservation area (HPCA) model 

The following are the process steps preformed in ArcGIS 10.1 to create the weighted 

arithmetic model and to determine high priority conservation areas for biodiversity in the 

Kromma Kill, Dry River, and Salt Kill drainage areas (watersheds and storm-watersheds) 

in Albany County, New York:  

1. Data pre-processing 

a. Collect data for criteria representing areas which may be high priority for 

biodiversity conservation  

i. Vector 

1. DEC regulated wetlands (polygon)  

a. Presence or absence of wetlands in an area 

2. United States protected areas (polygon)  

a. Connectivity: Distance to protected areas 

3. New York State Roads (line)  

a. Distance from roads 

4. New York State Streams (line)  

a. Proximity to riparian zones 

5. New York State Lakes (polygon) 

a. Proximity to riparian zones 

ii. Raster 

1. Land cover: Forests (tiff)  

a. Presence or absence of forests in an area 

2. Impervious surfaces (tiff) 

a. Amount (%) imperviousness 

b. Download, unzip, define projections, and project all of the shapefiles into 

NAD 83 State Plane NY East FIPS 3101 (feet)  

2. Coordinate System and Projection: NAD 83 State Plane NY East FIPS 3101 (feet) 

a. Open ArcMap 

i. Set data frame to the NAD 83 State Plane NY East FIPS 3101 

(feet) 

1. View>Data Frame Properties 

ii. Set Spatial Analyst to use the coordinate system of the data frame 

for all output 

1. Spatial Analyst>Options 

3.  Add all of the following layers to the map:  

a. Albany County (civil boundary) 

b. DEC regulated wetlands  

c. United States protected areas  

d. New York State Roads  

e. New York State Lakes and Streams 

f. Imperviousness 

g. Land cover  
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4. Use Albany County as the boundary for the data (but is larger than the study 

area).  

a. Select by location using Albany County and choose all of the above data 

layers as the “intersect” the source layer (for vector data). 

b. Use spatial analyst to “extract by mask” (Albany County is the mask) the 

land cover and imperviousness (raster data).  

5. Process steps for each of the above mentioned shapefiles:  

a. DEC Regulated Wetlands 

i. The metric will be presence/absence of a wetland plus a 30-meter 

buffer around it. 

ii. The grid will be integer, and the values of the grid will be 3 

(presence) or 0 (absence/NoData). 

iii. Input Data Layer: wetlands, vector, line 

1. STEP 1: Create a 30-meter buffer that is dissolved with the 

wetland 

a. Analysis Tools in toolbox>Proximity>Buffer 

i. Input: wetlands 

ii. Distance: 30 m 

iii. Dissolve: All 

iv. Output: wetlands buffer  

v. NOTE: In buffering the line, the vector 

becomes a polygon; this is necessary in 

order to convert the shapefile into a raster 

later.   

2. STEP 2: Add an integer field called “Value” to the buffered 

layer. Calculate Value = 3. 

a. Open VAT of wetlands buffer 

i. Options>Add Field>Value (Short Integer) 

ii. Right Click on new field>Field 

CalculatorValue=3 

3. STEP 3: Convert the buffered layer to a 30-meter grid 

format, using the Value field (this is the vector to raster 

conversion step) 

a. Toolbox>Conversion tools>To raster from polygon 

i. Input: wetlands buffer 

ii. Value field: Value 

iii. Cell Size: 30 

iv. Output: wetlands_rast 

4. STEP 4: Reclassify the wetland raster 

a. Spatial Analyst>Reclass>Reclassify 

i. Input: wetlands_rast 

ii. Reclass field: Value 

iii. Unique3=3 and No data=0 

iv. Saved as wetlands_reclass  

iv. Output Data Layer: wetlands_reclass, raster, 30mx30m 

b. United States protected areas 
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i. The metric will be distance from a protected area. 

ii. The grid will be integer, and the values of the grid will be 0 (over 

805m away or No Data), 1 (between 805 and 402m away), 2 (less 

than 402m away not including adjacent parcels), and 3 (adjacent). 

iii. Input Data Layer: Protected areas, vector, polygon 

1. STEP 1: Create a multiple ring buffer (30m, 402m, and 

805m) that is dissolved based on distance 

a. Analysis Tools in toolbox>Proximity>Multiple 

Ring Buffer 

i. Input: Protected Lands 

ii. Distance: 30m, 402m, and 805m 

iii. Dissolve: All 

iv. Output: pa_buffer 

v. NOTE: Although the 30m buffer is not one 

of the distances we used in the criteria, it 

was used here as a way to account for lands 

that are adjacent to the protected land.  If 

this buffer was not created, the land that was 

less than 402m and the lands adjacent to the 

protected lands would have been lumped 

together.   

2. STEP 2: Add an integer field “Value” to the buffered layer. 

Calculate Value = 3 (for the row with a distance of 30m), 2 

(for the row with a distance of 402m), and 1 (for the row 

with a distance of 805m). 

a. Open VAT of pa_buffer 

i. Options>Add Field>Value (Short Integer) 

ii. Start an editing session 

1. Edit Value = 3, 2, and 1 accordingly 

3. STEP 3: Convert the buffered layer to a 30-meter grid 

format, using the Value field 

a. Toolbox>Conversion tools>To raster from polygon 

i. Input: pa_buffer 

ii. Value field: Value 

iii. Cell Size: 30 

iv. Output: pa_rast 

4. STEP 4: Reclassify the protected area raster 

a. Spatial Analyst>Reclass>Reclassify 

i. Input: pa_rast 

ii. Reclass field: Value 

iii. Unique3=3, 2=2, 1=1, and No data=0 

iv. Saved as pa_reclass 

iv. Output Data Layer: pa_reclass, raster, 30mx30m 

c. Roads 

i. The metric will be distance from roads. 



59 

 

ii. The grid will be integer, and the values of the grid will be 0 (< 

50m from a road), 1 (between 50m and 100m from a road), 2 

(between 100m and 200m from a road), and 3 (> 200m form a 

road). 

iii. Input Data Layer: Roads, vector, line 

1. STEP 1: Create a multiple ring buffer (50m, 100m, and 

200m) that is dissolved based on distance 

a. Analysis Tools in toolbox>Proximity>Multiple 

Ring Buffer 

i. Input: Roads 

ii. Distance: 50m, 100m, and 200m 

iii. Dissolve: All 

iv. Output: roads_buffer 

2. STEP 2: Add an integer field “Value” to the buffered layer. 

Calculate Value = 2 (for the row with a distance of 200m), 

1 (for the row with a distance of 100m), and 0 (for the row 

with a distance of 50m). 

a. Open VAT of roads_buffer 

i. Options>Add Field>Value (Short Integer) 

ii. Start an editing session 

1. Edit Value =  2,1,  and 0  

accordingly 

3. STEP 3: Convert the buffered layer to a 30-meter grid 

format, using the Value field 

a. Toolbox>Conversion tools>To raster from polygon 

i. Input: roads_buffer 

ii. Value field: Value 

iii. Cell Size: 30 

iv. Output: roads_rast 

4. STEP 4: Reclassify the roads raster 

a. Spatial Analyst>Reclass>Reclassify 

i. Input: roads_rast 

ii. Reclass field: Value 

iii. Unique 2=2, 1=1, 0=0 and No data=3 

iv. Saved as roads_rc  

iv. Output Data Layer: roads_rc, raster, 30mx30m 

d. Lakes and Streams 

i. The metric will be proximity to riparian zone. 

ii. The grid will be integer, and the values of the grid will be 0 (over 

76m away), 1 (between 76m and 53m away), 2 (between 53m and 

30m away), and 3 (less than 30m away). 

iii. Input Data Layers: Lakes and Streams, vectors, line and polygon 

1. STEP 1: Buffer the streams so they become a polygon layer 

and can be merged with the lakes 

a. Analysis Tools in toolbox>Proximity> Buffer 

i. Input: Streams 
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ii. Distance: 30m 

iii. Dissolve: All 

iv. Ouput: streams_buffer 

2. STEP 2: Merge the lakes and the streams so they become 

one layer and can be buffered together 

a. Data Management Tools in the 

toolbox>General>Merge 

i. Input: lakes, streams_buffer 

ii. Ouput: water_merge 

3. STEP 3: Create a multiple ring buffer (30m, 53m, and 76m) 

that is dissolved based on distance 

a. Analysis Tools in toolbox>Proximity>Multiple 

Ring Buffer 

i. Input: water_merge 

ii. Distance: 30m, 53m, and 76m 

iii. Dissolve: All 

iv. Ouput: water_buffer 

4. STEP 4: Add an integer Value field to the buffered layer. 

Calculate the Value = 3 (for the row with a distance of 

30m), 2 (for the row with a distance of 53m), and 1 (for the 

row with a distance of 76m). 

a. Open VAT of water_buffer 

i. Options>Add Field>Value (Short Integer) 

ii. Start an editing session 

1. Edit Value = 3, 2, and 1 accordingly 

5. STEP 5: Convert the buffered layer to a 30-meter grid 

format, using the Value field 

a. Toolbox>Conversion tools>To raster from polygon 

i. Input: water_buffer 

ii. Value field: Value 

iii. Cell Size: 30 

iv. Output: water_rast 

6. STEP 6: Reclassify the water raster 

a. Spatial Analyst>Reclassify 

i. Input: water_rast 

ii. Reclass field: Value 

iii. Unique3=3, 2=2, 1=1, and No data=0 

iv. Saved as water_reclass  

iv. Output Data Layer: water_reclass, raster, 30mx30m 

e. Imperviousness 

i.  The metric will be the % of impervious surface. 

ii.  The grid will be integer, and the values of the grid will be 0 

(>35% imperviousness), 1 (10%-35% imperviousness), 2 (5%-

10%  imperviousness), and  3 (< 5% imperviousness). 

iii. Input Data Layer: imperviousness06, raster, 30mx30m 

1. STEP 1: Reclassify the imperviousness raster  
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a. Spatial Analyst>Reclass>Reclassify 

i. Input: imperviousness06 

ii. Reclass field: Value 

1. Click on “Classify” 

2. Choose “Equal Interval: with 20 

classes 

iii.  0 = >35%, 1 = 10%-35%, 2 = 5%-10%, and  

3 = <5% 

iv. Saved as imperv_reclass  

iv. Output Data Layer: imperv_reclass, raster, 30x30 

f. Land cover: Forests 

i. The metric will be presence or absence of forests. 

ii. The grid will be integer, and the values of the grid will be 0 

(forests absent) and 3 (forests present). 

iii. Input Data Layer: Land Cover 06, raster, 30mx30m 

1. STEP 1: Extract by attribute for forests 

a. Spatial Analyst Tools in 

toolbox>Extraction>Extract by Attributes 

i. Input: Land Cover 06 

ii. Where: "VALUE" = 41 OR "VALUE" = 42 

OR "VALUE" = 43  

iii. Output: forest_rast 

iv. NOTE: These are the values associated with 

data in the land cover layer which have 

information associated with types of forests 

(NLCD 2006)  

2. STEP 2: Reclassify the imperviousness raster  

a. Spatial Analyst>Reclass>Reclassify 

i. Input: forest_rast 

ii. Reclass field: Value 

iii. Unique41=3, 42=3, and 43=3 

iv. Saved as forest_reclass  

iv. Output Data Layer: forest_reclass, raster, 30mx30m 

6. Analysis 

a. Add the grid layers together using the Spatial Analyst>Overlay>Weighted 

Sum tool.   

i. Input rasters:  

1. wetlands_reclass 

2. pa_reclass 

3. roads_reclass 

4. water_reclass 

5. imperv_reclass 

6. forest_reclass 

ii. Output raster: Model_Full 

1. This model now includes all of Albany County  
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b. The Model_Full was then reclassified to match the way the criteria were 

valued from 0 to 3 

i. Spatial Analyst>Reclass>Reclassify 

1. Input: Model_Full 

2. Reclass field: Value 

a. Click on “Classify” 

b. Choose “Equal Interval”: with 4 classes 

c. 0 = 0-4.5, 1 = 4.5-9, 2 = 9-13.5, and  3 = 13.5-18 

d. Saved as Model_Full_Reclass 

c. Use the existing protected areas in Albany County shapefile to create a 

mask that will be used on the “Model_Full_Reclass” grid so the model 

showing only areas outside of the already-protected areas remains.  Save 

as “Model_Mask” in MODEL gdb (this is done using ArcInfo license) 

i. Create an erase mask on the County Layer using the Protected 

areas 

1. Analysis Tools>Overlay>Erase 

a. Input: Albany County 

b. Erase: PAD_US 

c. Output: Unprotected_Areas_AlbanyCounty 

ii. Mask the model 

1. Spatial Analyst>Extraction>Extract by mask 

a. Input raster: Model_Full_Reclass 

b. Input mask data: 

Unprotected_Areas_AlbanyCounty 

c. Output: Model_Mask 

i. The “Model_Mask” is the high priority 

conservation area model and has been 

created for all of Albany County.  

d. From the high priority conservation model, the Kromma Kill, Dry River, 

and Salt Kill watersheds and storm-watersheds were extracted for further 

analysis.   

GIS Data Sources for HPCA model: 

Census Roads, New York State [computer file]. Washington, D.C.: United States  

Department of Commerce United States Census Bureau Geography Division, 

2001.   

National Hydrography Dataset (NHD) for New York State [computer file]. Albany, NY:  

New York State Department of Environmental Conservation (NYSDEC) and 

United States Geological Survey (USGS), 2008.  

National Land Cover Dataset (NLCD) [computer file]. The Multi-Resolution Land  
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Characteristics (MRLC) Consortium, United States Department of the Interior, 

and United States Geological Survey (USGS), 2006.  

New York State Civil Boundaries [geodatabase]. Albany, NY: New York State Office of  

Cyber Security and Critical Infrastructure Coordination (CSCIC), 2010.  

New York State Regulatory Freshwater Wetlands for Albany County [computer file].  

Albany, NY: New York State Department of Environmental Conservation 

(NYSDEC), 1999.  

New York State Watershed Delineations [computer file]. StreamStats Web Mapper,  

United States Geological Survey (USGS), 2012.   

Protected Areas Database of the United States (PAD-US) Version 1.3 [geodatabase].  

USGS Gap Analysis Program (GAP), 2010.  

United States Fish and Wildlife Service. National Wetlands Inventory [geodatabase]. Jan  

1, 2013  

Waterbody Inventory and Priority Waterbodies List (WI/PWL) [computer file]. Albany,  

NY: New York State Department of Environmental Conservation (NYSDEC), 

2007.  

 

 

 

 

 

 


